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Object Research Systems (ORS) Inc.

This document describes the new features, product enhancements, and other 
improvements implemented in the Dragonfly and Dragonfly Pro 2021.1 software 
release. You should read these release notes before you install this new version.
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New Features and Product Enhancements
The 2021.1 software release for Dragonfly and Dragonfly Pro provides new features, 
product enhancements for the Segmentation Wizard and CT Reconstruction, new deep 
learning architectures, as well as support for additional file formats.

Segmentation Wizard
This Dragonfly release features a number of significant advancements for the 
Segmentation Wizard, which provides an easy-to-use, guided workflow for 
implementing powerful deep learning and machine learning segmentation of multi-
dimensional images.

Model Generation Strategy
The reformatted Model Generation Strategy dialog provides new options for creating 
and editing model generation strategies, as well as for quickly reviewing and editing 
Deep Learning model settings and feature presets for Machine Learning (Classical) 
models.

The Model Generation Strategy dialog, shown below, appears when you click Train and 
the models list is empty. You can also click the Open button the Models tab to open the 
dialog (see Updates for the Models Tab on page 9).

Model Generation Strategy dialog

The Model Generation Strategy dialog includes a list of the ORS default strategies and 
user-defined strategies, as well as a list of each model included in the selected strategy. 
Each model in the selected strategy can also be expanded to review and edit its settings.

You can do the following in the Model Generation Strategy dialog:

• Add a new strategy, import and export strategies, duplicate a strategy, and delete a 
strategy.

• Set a strategy as the default.

• Edit user-defined strategies, including renaming, adding, and removing models.
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• Edit the model parameters for Deep Learning models, as shown below.

• Add and remove feature presets for Machine Learning (Classical) models.

NOTE ORS defined strategies are read-only and all editing functionalities are dis-
abled for these strategies.

The controls and options that are now available in the dialog are described below:

Controls and options for the Model Generation Strategy dialog

Icon Description

Expand all models Expands all models in the list so that you can review and edit the parameters of Deep Learning 

models and the feature presets of Machine Learning (Classical) models.

Collapse all models Collapses the list of all models.

Select all models Selects all models in the list.

NOTE Selected models will be generated whenever you click Continue or Apply.

Deselect all models Deselects all models in the list.

Add new model Adds a new model to the selected strategy. You can choose the type of model in the drop-down 

menu, as shown below.

NOTE ORS defined strategies are read-only. You cannot add models to these strategies.

Remove selected model Removes the selected model from the selected strategy.

NOTE ORS defined strategies are read-only. You cannot remove models from these strategies.
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Default Strategies
Two ORS-defined default strategies — Quick Start and High Accuracy — are available 
for the Segmentation Wizard in this software release.

Quick Start… The models in this strategy, which are listed below, generally provide 
good results without excessive processing times.

• Random Forest with features presets Morphological, Gaussian_MS, and Neighbors.

• Random Forest with features preset Activation Map 2.

• U-Net (depth = 3, initial filters count = 64).

High Accuracy… The models in this strategy, which are listed below, are more 
demanding than those in ‘Quick Start’, but can provide a higher level of accuracy.

• Random Forest with features preset ‘Activation Maps 2’.

• U-Net (depth = 4, initial filters count = 64, multi-slice input with 3 slices).

• Sensor 3D (depth = 3, initial filters count = 64).

Add new features preset Lets you add a new features preset to the selected Machine Learning (Classical) model. You 

can choose features presets in the drop-down menu, as shown below.

NOTE ORS defined strategies are read-only. You cannot add feature presets to any Machine 

Learning (Classical) model in these strategies.

Remove selected features 

preset

Removes the selected features preset from the selected Machine Learning (Classical) model.

NOTE ORS defined strategies are read-only. You cannot remove feature presets from any 

Machine Learning (Classical) model in these strategies.

Save Saves any changes you made to the model generation strategy or to the settings of a model 

within a user-defined strategy.

Reload Reloads the current strategy.

Continue/Apply Continue… Is available when the Model Generation Strategy dialog appears after clicking 

‘Train’. In this case, all selected models in the current strategy will be generated when training 

begins.

Apply… Appears when the Model Generation Strategy dialog is opened from the Models tab. 

In this case, all selected models will only be generated.

NOTE You can choose to train or not train generated models on the Models tab on the 

Segmentation Wizard panel.

Close Closes the dialog.

Icon Description
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Updates for the Input Tab
The following options are now available on the Input tab, shown below. These options 
let you change the image modality shown in the views, control the visibility of frames 
and label highlights, as well as save, import, and fill frames.

Input tab

Image modalities… This new addition to the Input tab appears only when multiple 
datasets were selected for multi-modality training. Selecting an image in the list will 
automatically change the modality displayed in the workspace views and update the 
image data selected for defining a range in the ROI Tools panel.

Visibility controls… This new control, which appears on the left-side of the frames list, 
lets you show or hide a frame and the highlight applied to labeled voxels within the 
frame.

Import and Save… These new options for Dragonfly 2021.1 let you save frames as a 
labeled multi-ROI in the same shape as the input dataset(s), as well as to import saved 
frames to resume or duplicate a workflow.
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FILL… This modified item, which was previously ‘Fill from Object’, now lets you also fill 
all new frames from the currently selected model prediction.

Updates for the Models Tab
The Models tab now includes the option to open the Model Generation Strategy dialog, 
in which you can choose a model generation strategy, create new strategies, edit 
strategies, and generate models (see Model Generation Strategy on page 5). This new 
option is circled below.

Models tab

Updates for the Settings Tab
The Settings tab now includes the option to allow duplicate models. This option, which 
is circled below, should be enabled if you plan to generate and train similar models that 
are set with different parameters.

Settings tab
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Training Parameters
A number of new options — Save as Defaults, Load Defaults, and Reset Defaults — are 
available for the edited training parameters of Deep Models. Right-click the Deep Model 
you need to edit on the Models tab and then choose Update Training Parameters in the 
pop-up menu to open the Training Parameters dialog, shown below.

Training Parameters dialog

Options for saving and applying edited training parameters

Description

Save as Defaults Saves the current settings as the default values, which will be applied to new 

models.

Load Defaults Restores the settings to the last saved default values.

Reset Defaults Resets all settings to their original values.

Apply to The ‘Apply to’ options have been streamlined to include the following:

Current deep model… If selected, all changes will be applied to the selected 

Deep Learning model only.

All current deep models… If selected, all changes will be applied to all Deep 

Learning models in the current Segmentation Wizard session.
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Model Parameters
The model parameters for Deep Learning models selected in the Model Generator dialog 
have been renamed and also include informative tooltips, as shown in the following 
screen capture.

Model Generator dialog

Rename and Save Multiple Models
As an additional change for the Segmentation Wizard in Dragonfly 2021.1, whenever 
you exit the Segmentation Wizard, or click the Save button on the Models tab, a new 
Save dialog now appears onscreen.

Save dialog

You can do the following in the reformatted Save dialog:

• Choose the model or models that you want to save.

• Rename a model before it is saved.
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Data Selection
The Data Selection dialog, shown below, now appears whenever you open the 
Segmentation Wizard from data selected in the Data Properties and Settings panel.

Data Selection dialog

This change lets you easily choose the order of your inputs. You should also note that 
modalities order is important for training models and must be consistent for inference.

Open Wizard Session from the Menu Bar
Whenever you now choose to open the Segmentation Wizard from the Artificial 
Intelligence menu, you can reload an available Segmentation Wizard session. This new 
option is shown in the screen capture below.

Dragonfly menu bar

NOTE All frames, trained models, and training parameters are saved within Segmentation 
Wizard group objects. This lets you reproduce previous results, as well as share data with 
others.
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New Deep Learning Architectures
The following deep learning architectures — Attention U-Net, LinkNet, and U-Net++ — 
are now available for the Deep Learning Tool and the Segmentation Wizard for training 
semantic segmentation models.

Attention U‐Net
This novel attention gate (AG) model, which was originally designed for medical 
imaging segmentation, automatically learns to focus on target structures of varying 
shapes and sizes while suppressing irrelevant regions in input images. By highlighting 
salient features only, the necessity of using explicit external tissue/organ localization 
modules of cascaded convolutional neural networks (CNNs) is eliminated. Integrated 
into the standard U-Net architecture, AGs can increase model sensitivity and prediction 
accuracy.

REFERENCE… Oktay et al. Attention U-Net: Learning Where to Look for the Pancreas, 
arXiv, May 20, 2018 (https://arxiv.org/pdf/1804.03999.pdf).

LinkNet
This deep neural network architecture focuses on speed and efficiency for semantic 
segmentation tasks. Compared to other algorithms, LinkNet can learn with a more 
limited number of parameters and operations and still deliver accurate results.

REFERENCE… Abhishek Chaurasia and Eugenio Culurciello, LinkNet: Exploiting Encoder 
Representations for Efficient Semantic Segmentation, arXiv, June 14, 2017
(https://arxiv.org/pdf/1707.03718.pdf).

U‐Net++
U-Net++ is a powerful architecture for medical image and semantic segmentation. This 
architecture is a deeply-supervised encoder-decoder network in which the encoder and 
decoder sub-networks are connected through a series of nested, dense skip pathways. 
The skip pathways help reduce the semantic gap between the feature maps of the 
encoder and decoder sub-networks.

REFERENCE… Zhou et al. UNet++: A Nested U-Net Architecture for Medical Image 
Segmentation, arXiv, July 18, 2018 (https://arxiv.org/pdf/1807.10165.pdf).
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Updated Deep Learning Architectures
A number of updates and improvements for the PSPNet deep learning architecture are 
available in this software release.

PSPNet
The following changes were implemented for PSPNet, which can be trained for semantic 
segmentation.

Parameter to control filters count… Although this architecture has high memory 
demands, the newly implemented filters count controls should allow users with more 
limited GPUs to now train models with this updated version of PSPNet.

Default Patch size… Although PSPNet requires a Patch size of at least 256, the default 
has been reset to 512 for optimal performance.

In addition, a number of minor fixes were implemented for this architecture to improve 
data flow.
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CT Reconstruction
The following updates are available for the Beta version of the CT Reconstruction 
module in Dragonfly 2021.1.

Stripe Removal Filters for Pre‐Processing
The following stripe and ring artifact removal filters are now available for pre-processing 
acquisition data prior to reconstruction.

Wavelet‐Fourier… Removes horizontal stripes and ring artifacts from the sinogram 
using the Fourier-Wavelet (FW) based method.

Options for Wavelet‐Fourier stripe removal

The following adjustable parameters are available for the Wavelet-Fourier stripe 
removal filter. You should note that you can generate multiple previews to test your 
settings prior to reconstructing data and then import the inputs from the best preview.

Adjustable parameters for Wavelet‐Fourier stripe removal filter

NOTE Refer to Münch et al. Stripe and ring artifact removal with combined wavelet–fourier 
filtering, Optics Express, 17(10):8567-8591, 2009 for more information.

Titarenko… Removes horizontal stripes and ring artifacts from the sinogram using 
Titarenko’s approach.

Options for Titarenko stripe removal

The adjustable parameters available for the Titarenko stripe removal filter include 
‘Number of blocks’ and ‘Alpha (damping factor)’. You should note that you can generate 
any number of previews to test your settings prior to reconstructing data and then 
import the inputs from the best preview.

NOTE Refer to Miqueles et al. Generalized Titarenko’s algorithm for ring artefacts reduction, 
Journal of Synchrotron Radiation, 21(6):1333-1346, 2014 for more information.

Parameter Description

Level Lets you set the number of discrete wavelet transform levels.

Sigma Lets you set the sampling parameter in Fourier space.

Wavelet Lets you select the type of the wavelet filter — ‘db5’, ‘haar’, or ‘sym5’.
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Updates for the CT Rotation Finder
A number of updates are available in this software release for finding the center of 
rotation for reconstructing cone beam projections.

Choose Workflows > CT Reconstruction to start the CT Reconstruction module. You can 
then open the CT Rotation Finder dialog, shown below, by clicking the Find Rotation 
Center button in the Reconstruction engine box.

CT Rotation Finder dialog

Do the following to change the source offset and optimize the algorithm for computing 
the center of rotation for cone beam projections:

1. Enter or import the acquisition parameters for the projection that you want to 
reconstruct in the CT Reconstruction dialog.

2. Click the Find Rotation Center button.

The CT Rotation Finder dialog appears.

3. Select Image metric as the method in the CT Rotation Finder dialog.

4. Select a metric type — Shannon entropy or Sharpness — in the Metric type drop-
down menu.

5. Check the Change source offset option.
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6. Click the Refresh button to compute a metric cost function vs. rotation center offset 
curve, recommended.

NOTE If required, you can adjust the minimum and/or maximum offset ranges, as 
well as the number of points, before you compute the curve.

7. Set the Minimum and Maximum offset values (pixelwise) to an optimal range, 
recommended. Adjustments can be made on the curve by dragging the thresholds, 
as shown below, or by entering new values in the edit boxes, as circled below.

NOTE You can modify the Number of optimizations and Precision (pixelwise), if 
required.

8. Click the Update Preview button to compute the optimal center of rotation.

After the computation is complete, a preview of the result appears in the dialog.

9. Examine the preview with the Preview tools, recommended, and then do one or 
more of the following:

• Click the OK button at the bottom right of the dialog to apply the computed 
rotation center offset value and update the Source offset and Detector offset 
values in the CT Reconstruction dialog.

• Click the Export Preview button to export the preview and its settings. You can 
import the inputs from the best preview in the CT Reconstruction dialog.
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• Click the Shannon Entropy Curve or Sharpness Curve button to plot the curve of 
the selected Image metric vs. the offset within the computed range, as shown 
below.

• Select Manual range as the method and then generate additional previews 
centered on the found value.

Support for YXLON Micro‐CT Scans
This software release provides support for reconstructing projection data acquired with 
YXLON micro-CT scanning systems. As shown in the screen capture below, acquisition 
parameters can be imported from accompanying XML files (*.xml extension).

Acquisition parameters

NOTE You can use Dragonfly’s CT Rotation Finder to accurately find the center of rotation (see 
Updates for the CT Rotation Finder on page 16.

Metadata Parser for SKYSCAN
A geometry reader is available in this software release for parsing the metadata of cone 
beam projections acquired with SKYSCAN micro-CT systems.

Select SkyScan in the CT scanner manufacturer drop-down menu and then click the 
Import button. You can choose the log file (*.log extension) with the scan metadata to 
load the acquisition parameters.

NOTE SKYSCAN is a registered trademark of the Bruker Corporation.
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Distributed Tasks
Dragonfly’s high-performance compute (HPC) framework lets you distribute compute-
heavy tasks to other Dragonfly workstations, dedicated HPC clusters, or to elastically 
instantiated compute nodes on Amazon’s EC2 platform. Applicable tasks include training 
deep models with the Deep Learning Tool and the Segmentation Wizard, reconstructing 
projection data with the CT Reconstruction module, and generating simulations with 
MC X-Ray. Support for the inference of trained deep models, numerical modeling for 
LMB simulations, and image filtering will be available in future releases.

NOTE Distributed Tasks uses Python's distributed task queue Huey to support multi-threaded 
task execution, scheduled execution, periodic execution, resubmitting failed 
taskslkr444e, and task result storage.

NOTE Distributed Tasks is available as beta only and is a separately licensed feature for 
Dragonfly. Contact sales@theobjects.com for more information about licensing for 
Distributed Tasks.

Updates in this software release for Distributed Tasks include the addition of a 
distributed tasks observer and an updated dialog for monitoring the progress of queued 
tasks for the Segmentation Wizard.

Distributed Tasks Observer
The newly implemented Distributed Tasks Observer dialog lets you monitor the progress 
of all tasks within a selected queue. Additional options let you:

• Clear completed tasks, tasks with error, pending tasks, or selected tasks.

• Resubmit processing tasks, as well as tasks with errors.

• Clear temporary data.

• Add and manage cloud computers.

Choose Utilities > Start Distributed Tasks Queue Observer on the menu bar to open the 
Distributed Tasks Observer dialog, as shown below.

Distributed Tasks Observer dialog
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Distributed Task Dialog
After launching a distributed task from the Segmentation Wizard for training a deep 
model, you can monitor training progress in Distributed Task dialog, shown below. 
Distributed tasks can be launched by clicking the Train Distributed button.

Distributed Task dialog

You can do the following in the Distributed Task dialog:

• Monitor the status — Pending, Executing, and Completed  — and progress of all 
launched tasks.

• Cancel or stop a task.

• Display the details of the training task in progress. Click the Display Progress button 
to open the Training dialog, shown below.

Updates for the Deep Learning Tool
Updates for the Deep Learning Tool when using Distributed Tasks include additional 
controls to resubmit a training task, stop training, and to display the details of training 
progress. These are available by right-clicking a model on the Model Overview panel. 
You should also note that the Model Status was updated for Distributed Tasks.
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ROI Painter Panel
The reformatted ROI Painter panel not only includes a more intuitive layout, but also 
provides new tools, such as a Local Otsu brush and Adaptive Gaussian brush, for 
tackling challenging segmentation tasks. Updates for the Path tool and the Point & Click 
tool are also included in this software release.

The reformatted panel for working in 2D and 3D views are shown below.

ROI Painter tools for 2D views (left) and 3D views (right)

NOTE Activation of the Round and Square Brushes now requires only a single click instead of 
two. Macros previously created with these brushes will only be supported for a limited 
time.
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New ROI Painter Tools
A number of new ROI Painter tools, including a set of local adaptive threshold brushes, 
are now available for tackling challenging segmentation problems. You should note that 
adaptive thresholding changes the threshold dynamically over an image by determining 
the threshold for a pixel based on a small region around it. This can provide better 
results for images with strong illumination gradients or shadows when compared to 
applying a constant threshold. The assumption is that smaller image regions are more 
likely to have approximately uniform illumination.

In addition to these new ROI Painter tools, this software release also provides an outline 
mode for the Point & Click tool and a selectable thickness for the Path tool when 
working in Multi-slice mode.

Local Otsu Brush
The threshold value of the new Local Otsu brush is determined by maximizing the 
variance between two classes of pixels of the local neighborhood defined by the area or 
volume of the Round or Square brush. The dataset that provides the values for 
computing the threshold can be selected in the Image drop-down menu and you can 
choose to paint within the Lower or Upper range. 

Local Otsu brush settings

An example of painting with the Local Otsu brush set to the Upper class is shown in the 
screen capture below.

Painting with the Local Otsu brush 
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Adaptive Gaussian Brush
The threshold value of the new Adaptive Gaussian brush is the weighted sum of 
neighbourhood values subtracted by a constant, where the weights are a Gaussian 
window. The dataset that provides the values for computing the threshold can be 
selected in the Image drop-down menu and you can choose to paint within the Lower or 
Upper range. The neighbourhood is defined by the area or volume of the Round or 
Square brush.

Adaptive Gaussian brush settings

Sigma… Is the amount of variation or dispersion of the set of values within the defined 
neighborhood.

Offset… Is the constant subtracted from the weighted sum of neighborhood to calculate 
the local threshold value.

An example of painting with the Adaptive Gaussian brush set to the upper range is 
shown in the screen capture below.

Painting with the Adaptive Gaussian brush
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Point & Click Brush
You can now choose the level of connectivity — 4-connected and 8-connected for 
Single-slice mode and 6-connected and 26-connected for Multi-slice and 3D modes — 
for working with the Point & Click brushes.

Other options for the Point & Click brush now include an Outline mode, which is 
activated in the screen capture shown below.

Point & Click brushes and settings

An example of painting with the Point & Click brush in Outline mode is shown below.

Painting with Point & Click brush in Outline mode

You should note that in image processing, connectivity is the way in which pixels in 2D 
images and voxels in 3D images relate to their neighbors. 

When working in Single-slice mode in 2D views, connectivity is selectable as follows:

4‐connected… Propagation is done by strictly using the 4 edges adjacent to the current 
seed and will result in the minimum number of connected pixels.

8‐connected… Propagation is done by strictly using the 4 edges and 4 corners adjacent 
to the current seed and will result in the maximum number of connected pixels.

When working in Multi-slice mode in 2D views and in 3D views, connectivity is 
selectable as follows:

6‐connected… Propagation is done by strictly using the 6 faces adjacent to the current 
seed and will result in the minimum number of connected voxels.

26‐connected… Propagation is done by strictly using the 6 faces, 8 corners, and 12 
edges adjacent to the current seed and will result in the maximum number of connected 
voxels.
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Point & Click Outline Brush Preferences
The following configured actions are available for the new Point & Click Outline brush.

Configured actions for the Point & Click Outline brush

Path Brush
The Path brush now has a selectable thickness when working in Multi-slice mode. 
Thickness can be selected with the slider, as shown below.

Thickness slider for the Path brush

Export Label Histograms
This software release provides the option to export histograms of labeled data in the 
comma-separated values (*.csv extension) file format. In this case, the data associated 
with each label will appear in a separate row and the number of pixels in each bin will 
appear in the columns.

Right-click the required multi-ROI labels in the Classes and scalar information box and 
then choose Export Label Histograms to CSV in the pop-up menu. You can then choose 
the image to extract the values for the histograms in the Choose an image to create 
histograms dialog, shown below.

Choose an image to create histograms dialog

NOTE You can select up to a maximum of 1000 labels for exporting label histograms to CSV.

Action Defaults

Activate point & click outline add LEFT CTRL

Activate point & click outline remove LEFT SHIFT

Add to Point & Click Outline LEFT CTRL + Left mouse

Decrease point & click outline brush size in add mode LEFT CTRL + Mouse wheel down

Decrease point & click outline brush size in remove mode LEFT SHIFT + Mouse wheel down

Increase point & click outline brush size in add mode LEFT CTRL + Mouse wheel up

Increase point & click outline brush size in remove mode LEFT SHIFT + Mouse wheel up

Remove from Point & Click Outline LEFT SHIFT + Left mouse
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Morphological Operations
A number of new options are available on the ROI Tools panel for applying 
morphological operations to regions of interest and the selected class(es) of multi-ROIs. 
These are available in the Morphological operations box, which is shown below.

Morphological operations

Dimensionality… Lets you apply the selected morphological operation in 3D, in which 
case the operation will be applied to all axes, or in 2D, in which the case the operation 
can be applied along the X, Y, or Z axis.

Range… You can choose selected slices, a range of image slices and an increment, or a 
combination of both, to which the selected morphological operation will be applied. For 
example, if you enter 1,2,3-5,6-15/3, then the operation will be applied to slices 1, 2, 
3, 4, 5, 6, 9, 12, and 15.

ROI and Mesh Opacity Settings
You should note that for regions of interest and meshes, the applied color box is now 
split diagonally between the original color on the left, while the color on the right 
corresponds to the original color at the applied opacity setting.

Examples of the reformatted color boxes are circled in the screen capture below.

Data Properties and Settings panel
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Window Leveling Modes for 3D Views
Available in the 3D settings box on the Data Properties and Settings panel and circled 
below, the additional Window Leveling modes that are available in Dragonfly 2021.1 can 
help you fine-tune renderings to optimize visualizations.

WL modes for 3D views

The following Window Leveling modes are available for 3D views in this software 
release.

Description of the WL modes for 3D views

Mode Icon Description

Left-gated ramp In this mode, the opacity of the values to the left of the lower threshold will be set to 0, while the 

upper threshold is disabled. The opacity of the values within the window are set within a linear 

ramp, which can be modified by adjusting the local gamma on the Window Leveling panel.

NOTE This mode was previously the default behavior for the next generation rendering engine.

Bi-gated ramp In this mode, the opacity of the values to the left of the lower threshold will be set to 0, while the 

opacity of the values to the right of the upper threshold will be set as per the highest value 

within the window. The opacity of the values within the window are set within a linear ramp, 

which can be modified by adjusting the local gamma on the Window Leveling panel.

NOTE This mode was previously the default behavior for the legacy rendering engine.

Band pass ramp In this mode, the opacity of the values to the left of the lower threshold and to the right of the 

upper threshold will be set to 0. The opacity of the values within the window are set within a 

linear ramp, which can be modified by adjusting the local gamma on the Window Leveling 

panel.

Band pass Gaussian In this mode, the opacity of the values to the left of the lower threshold and to the right of the 

upper threshold will be set to 0. The opacity of the values within the window are set within a 

Gaussian window, which can be modified by adjusting the local gamma on the Window 

Leveling panel.

Band pass constant In this mode, the opacity of the values to the left of the lower threshold and to the right of the 

upper threshold will be set to 0. The opacity of the values within the window are set to a 

constant 50%.

NOTE The local gamma cannot be adjusted in this mode.
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The following illustrations demonstrate some of the differences between the Window 
Leveling modes for 3D views.

Left‐gated mode (left) vs. Bi‐gated mode (right)

In this case, gating the upper values with the Bi-gated mode results in a much more 
detailed rendering.

Left‐gated mode (left) versus Band pass ramp

In this case, setting the highest values to 0 with the Band pass ramp results in much 
more detail in the mid-level values.
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Left‐gated mode (left) versus Band pass constant (middle) and Band pass Gaussian (right) modes

In this case, voxels within the middle and upper values appear with greater detail and 
solidity in the Band pass constant and Band pass Gaussian modes.

W/L Mode Preferences
A new set of preferences are available for setting a default WL mode for 3D views. This 
setting — Default WL Mode — is available in the Views | 3D Settings preferences, as 
shown below.

Default WL Mode preference
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Image Filtering
The following updates are available for filtering image data in Dragonfly 2021.1.

Thresholding for Unimodal Images
There are many methods that provide appropriate threshold values for an image with a 
bimodal gray-level histogram. However, most of these methods cannot accurately and 
efficiently segment an image with a unimodal gray-level distribution. To address this 
limitation, the Liu‐Song‐S threshold filter has been added to Dragonfly for image 
filtering operations. By analyzing the morphology of the gray gradient distribution 
histogram, an optimal threshold for image segmentation can be obtained for images 
with unimodal gray-level distributions, as shown in the example below.

Original image (left) and the result of Liu‐Song‐S thresholding (right)

NOTE Refer to Song et al, A new automatic thresholding algorithm for unimodal gray-level 
distribution images by using the gray gradient information, Volume 190, July 2020
(https://www.sciencedirect.com/science/article/abs/pii/S0920410520301674) for 
additional information about this filtering technique.

Updates for Image Filters
A number of updates are available for the following filters in Dragonfly 2021.1.

DoG… The Difference of Gaussian (DoG) edge detection filter now supports 3D 
structuring elements, as shown in the following screen capture. 

New kernel options for DoG filter

NOTE In some cases, it can be more useful to interpret the input data of an image processing 
algorithm as a 3D volume instead of a sequence of 2D planes.
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Morphological gradient… This filter now includes the option to compute the external 
and internal gradients of the input image, circled below.

Gradient options for the Morphological Gradient filter

You should note that a morphological gradient is the difference between the dilation and 
the erosion of an image. It is an image in which each pixel value indicates the contrast 
intensity in the close neighborhood of that pixel. It is useful for edge detection and 
segmentation applications.

Mathematically, the morphological gradient (G) of f is given by:

G(f) = D(f) - E(f), where D and E denote dilation and erosion with the selected 
structuring element, respectively.

The internal gradient is given by: Gi(f) = f - E(f).

The external gradient is given by: Ge(f) = D(f) - f.

NOTE The internal and external gradients are “thinner” than the gradient. Gradient peaks are 
located on the edges, whereas the internal and external ones are located at each side of 
the edges. You should also note that Gi + Ge = G.



32 New Features and Product Enhancements
Three‐Point Circle Tool

Dragonfly Release Notes Version 2021.1

T
M

0
2

1
-A

-0
9

Three‐Point Circle Tool
The new Three-Point Circle tool for annotations, circled below, lets you create a circular 
region by simply clicking on a succession of three points in a 2D view. The smallest 
circle that can pass through the three points is computed automatically.

Three‐Point Circle tool (circled)

Measurements available for this region tool include the area and perimeter of the circle. 
You can also adjust the thickness of the annotation, select a control point size and style, 
as well as plot a histogram of the data values within the region.

Configured Actions for the Three‐Point Circle Tool
The following configured actions are available for the Three-Point Circle tool.

Configured actions for the Three‐Point Circle tool

Thickness Meshes
You can now choose to export the X-Y-Z coordinates of thickness meshes along with the 
scalar values when you export data in the comma-separated values (*.csv extension) 
file format.

Right-click the thickness mesh, choose Export Scalar Values in the pop-up menu, and 
then select Export with coordinates in the Choose Scalar Values Slots to Export dialog, 
as show below.

Choose Scalar Value Slots to Export dialog

The exported comma-separated values (*.csv extension) file will include columns for 
the X-axis coordinate, the Y-axis coordinate, and the Z-axis coordinate for each vertex, 
along with the corresponding scalar value(s).

Action Default key

Create circle from 3 points Left mouse
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Organizer Updates
Updates for Dragonfly’s Organizer include the option to find projects that contain 
session groups, such as those created by the Bone Analysis, Plug Analysis, and 
Segmentation Wizards, as well as a reformatted Organizer Settings dialog.

Search Criteria
The selectable objects for finding projects now includes Groups on the Objects tab in 
the Search Project dialog. This option is circled on the screen capture below.

Search criteria

Organizer Settings
The Organizer Settings are now arranged with a tree view on the left side and the 
parameters related to the current selection on the right. Click the Manage Settings 
button in the Organizer dialog to open the Organizer Settings dialog shown below.

Organizer Settings dialog

The Organizer Settings are available as described below.

Network… Lets you designate a server port and also lists the current IP address.

Roots… Lists the configured roots and lets you add and edit roots.

Project Tags… Lets you setup tags that are mandatory or optional when new projects 
are created.

Sharing… Lets you enable sharing and to add authentication.

Maintenance… Provides the option to build the database. Rebuilding may be required if 
you manually delete objects in a project or remove projects from a root folder outside 
of Dragonfly.
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Plug Analysis
As an update for Dragonfly’s Plug Analysis module, which provides a dedicated workflow 
for analyzing core plugs acquired from rock samples and other porous media, you can 
now control the opacity of the selected range highlight when using the Manual Range 
option to apply a threshold segmentation.

The option to adjust the opacity of the range highlight with the Range opacity slider, 
circled below, is available in the Preview box.

Range opacity slider

Movie Maker
This new release also features a number of improvements and enhancements for 
Dragonfly’s Movie Maker.

Clip sweeps… The option to choose the direction of clip sweeps is now available. To add 
a clip sweep, select the required keyframe and then choose a clip sweep in the Clip 
sweep drop-down menu, as shown below.

Clip sweep options

2D Animations
This new release provides the option to record 2D animations in the APNG file format  
(*.png extension) from the 2D Animation panel.

NOTE Animated PNG files will play automatically in most internet browsers, such as Google 
Chrome and Windows Edge. You should also note that animated PNGs generally have 
better quality than other file formats, such as GIF.
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Support for H5 Files
For Dragonfly Pro users, this software release includes a reader for importing files 
created with Xnovo’s GrainMapper3D software (*.h5 extension) from processed TXM 
files. GrainMapper3D provides non-destructive 3D crystallographic imaging through 
LabDCT on ZEISS Xradia 520/620 Versa X-ray microscopes made for laboratory use.

Choose File > Import GrainMapper File (h5) on the menu bar to automatically import a 
selected GrainMapper file.

Visualization of a GrainMapper H5 file in 3D

NOTE Subsequent analysis of grain maps in Dragonfly Pro lets you filter, analyze, and visualize 
data with parameters such as orientation, volume, sphericity, and others. Color coding 
can be chosen according to the selected scalar value.

Dragonfly Pro’s .h5 reader imports:

AbsorptionCT/Data… As a 3D dataset of the CT reconstruction, which is usually 
registered with the TXM reconstruction from the same experiment.

LabDCT/GrainID… As a 3D multi-ROI in which each GrainID appears in the Name 
column, along with the number of corresponding labeled voxels and scalar slots for 
completeness, Eigen values, and Rodrigues vectors.

The items available for an imported H5 file are shown in the following screen capture of 
the Data Properties and Settings panel.
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Imported .h5 file data in the Data Properties and Settings panel

NOTE GrainMapper3D is a registered trademark of Xnovo Technology ApS.

NOTE This option is available for Dragonfly Pro only. Contact ORS for information about the 
availability of this version of Dragonfly.

Additional Support for CZI Images
The additional support for importing CZI files in Dragonfly Pro now includes 
automatically reading stage positions from the metadata in order to orient data 
appropriately. You should also note that a known issue with scaling has also been 
resolved.

NOTE The option to import CZI files is available for Dragonfly Pro only. Contact ORS for 
information about the availability of this version of Dragonfly.

Export Images to VTK
The option to export image data in the VTK (*.vtk extension) file format is available in 
this software release.

Right-click the data you need to export in the Data Properties and Settings panel and 
then choose Export > Export Image to VTK in the pop-up menu. In this case, a channel 
as a vtkStructuredPoints with the channel data as a scalar slot will be exported.
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Menu Bar Changes
The following new items are available on the menu bar in Dragonfly 2021.1.

File Menu
A number of new items, listed below, are available in the File menu.

File menu changes

Utilities Menu
A number of new items, listed below, are available in the Utilities menu.

Utilities menu changes

Description

Import GrainMapper File 

(h5)

Lets you import files created with Xnovo’s GrainMapper3D software (*.h5 extension) from processed TXM 

files (see Support for H5 Files on page 35).

Description

Start Distributed Tasks 

Consumer

Opens the Distributed Tasks Consumer dialog, in which you can monitor the activity of consumers within a 

selected queue, as well as de-register synched consumers.

Start Distributed Tasks 

Queue Observer

Opens the Distributed Tasks Observer dialog, in which you can clear completed tasks, tasks with errors, 

pending tasks, or selected tasks, as well as resubmit processing tasks and clear temporary data (see 

Distributed Tasks Observer on page 19).



38 Changes to Contextual Menus
Dataset Pop‐Up Menu

Dragonfly Release Notes Version 2021.1

T
M

0
2

1
-A

-0
9

Changes to Contextual Menus
The following changes for the contextual menus available in the Data Properties and 
Settings panel are implemented in Dragonfly 2021.1.

NOTE The item ‘Extract Action Log from Object’ was renamed as ‘Extract Object History as 
Macro’ for this software release. Extracted macros not only provide an audit trail to help 
troubleshoot processing issues, but can be edited and replayed to create new objects.

Dataset Pop‐Up Menu
A number of new and modified items, listed below, are available in the Dataset pop-up 
menu.

Dataset pop‐up menu changes

Multi‐ROI Pop‐Up Menu
A number of new items, listed below, are available in the Multi‐ROI pop-up menu in the 
Data Properties and Settings panel.

Multi‐ROI pop‐up menu changes

Description

Export Two additional items now appear in the Export submenu.

As RBG… This option, which lets you export selected RGB channels in the BMP, JPEG, and PNG file 

formats, was previously available as a stand-alone item in Dataset pop-up menu.

To VTK… Lets you export image data in the VTK (*.vtk extension) file format (see Export Images to VTK 

on page 36).

Description

Label Histograms to CSV Lets you export label histograms in the comma-separated values (*.csv extension) file format (see Export 

Label Histograms on page 25).
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Preferences Changes
A number of new items, listed below, and other changes have been implemented for 
setting the application preferences.

Click Preferences on the Status bar or choose File > Preferences on the Menu bar to 
open the Preferences dialog.

Views Preferences
Changes for the Views preferences are indicated in the following table.

Views preferences changes

Configurable Actions
New configurable actions are available for annotations and the Point & Click Outline 
brush. Chose File > Preferences > Configurable Actions to access the configurable 
actions for Dragonfly.

Three‐Point Circle tool… See Three-Point Circle Tool on page 32 for the configured 
actions that let you create a circular region by simply clicking on a succession of three 
points in a 2D view.

Create a point in Point mode… The default action for adding points in Point mode was 
changed to LEFT CTRL + LEFT MOUSE in this software release. This should facilitate adding 
points to 3D views.

Point & Click Outline brush… See Point & Click Outline Brush Preferences on page 25 
for the actions related to the new Point & Click Outline brush.

Description

3D Settings

Default WL Mode Lets you select a default window leveling mode for 3D renderings (see Window Leveling Modes for 3D 

Views on page 27).
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Resolved Issues
A number of issues reported by users have been resolved in this software release. 

Labeling Multi‐ROIs
A number of updates and fixes for labeling multi-ROIs are included in Dragonfly 2021.1. 
These include a reformatted ROI Painter panel (see ROI Painter Panel on page 21), new 
ROI Painter tools (see New ROI Painter Tools on page 22), and new patterns for working 
in ‘Remove’ mode. You should note the following when working in ‘Remove’ mode.

• When a single label of a multi-ROI is selected in the Classes and scalar information 
box and you are working in ‘Remove’ mode, only voxels within the selected class will 
be removed. All other labels will remain as is.

• If no label of a multi-ROI is selected, then all labeled voxels will be removed when you 
are working in ‘Remove’ mode.

Working in 3D Views
Issues related to working with visual planes and clipping in cases in which a mesh is 
visible in the 3D view have been resolved in this software release.

3D Settings for Loaded Sessions
Settings for 3D visualizations, such as the applied LUT and the selected opacity, solidity, 
and other 3D settings, are now retained in saved sessions and will be reinstated when a 
session is loaded.

Issues with AMD Graphic Cards
Issues related to rendering data in 3D on systems with AMD cards have been fixed.

Movies Rendered in 4K
Reported issues related to rendering movies in 4K with Dragonfly’s MovieMaker have 
been fixed.

Exported Screenshots
Some users have reported that the values on legends in exported screenshots are not 
always well positioned. For example, numbers sometimes overlap with each other or 
the bar when exporting at different resolutions. This has been fixed.

Smoothing Meshes
Issues related to smoothing meshes with the Laplacian method should no longer occur 
in this software release.

Interpolating ROIs
The issue reported for interpolating the slice intervals of regions of interest in the ZY 
plane has been resolved in Dragonfly 2021.1.
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System Requirements
This release supports the base system requirements (see http://www.theobjects.com/
dragonfly/system-requirements.html).

Publicly Available Source Code
Users can freely download and examine the source code of the following.

TensorFlow
A number of Dragonfly’s artificial intelligence applications, such as the Deep Learning 
Tool, the Segmentation Wizard, and Segment with AI, use TensorFlow APIs to facilitate 
training and inference of deep neural networks. Created by the Google Brain team, 
TensorFlow is a free and open-source library widely used for deep learning applications 
and traditional machine learning. You should note that the version of TensorFlow 
implemented in Dragonfly 2021.1 and in previous versions is 1.14.0.

Users can freely download and examine the TensorFlow source code from:

https://github.com/tensorflow/tensorflow/releases/tag/v1.14.0.

Qt
Dragonfly is designed and developed with Qt, which is a free and open-source toolkit for 
creating graphical user interfaces and cross-platform applications. Qt is developed by 
The Qt Company, a publicly listed company, and is available under both commercial 
licenses and open-source GPL 2.0, GPL 3.0, and LGPL 3.0 licenses.

Users can freely download and examine the Qt source code from:

https://download.qt.io/official_releases/qt/5.9/5.9.7/.

Extending Dragonfly
Dragonfly’s Infinite Toolbox, an open exchange platform for the Dragonfly user 
community, lets you submit, browse, and download extensions that implement new 
features and workflows for all of your image processing or analysis needs.

Choose Utilities > Infinite Toolbox on the menu bar to open Dragonfly’s Infinite Toolbox.

Requesting New Features
Let us know if you have a suggestion for a new feature, or an idea for an improvement 
to an existing workflow.
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Learning Dragonfly
You’ll find some great free resources, such as our latest instructional videos, recorded 
webinars, and user forums just by taking a quick look around www.theobjects.com/
dragonfly/. You can also take advantage of the course offerings listed below to further 
benefit from our training team's in-depth product knowledge.

Dragonfly Workshops
Our hands-on training workshops are a great way to get up and running quickly. 
Combining in-depth instruction with class exercises, our product specialists will quickly 
teach you how to use key Dragonfly features and functions to optimize your image 
visualization and analysis tasks.

NOTE All scheduled Dragonfly workshops have been postponed or cancelled due to worries 
about the coronavirus pandemic. We will resume our workshop schedule as soon as 
possible. You can check for updates at http://www.theobjects.com/dragonfly/
workshops.html.

Online Training
Get connected with an online training session and follow along with a Dragonfly product 
specialist as they demonstrate the features and benefits of Dragonfly and walk you 
through specialized modules. Web-based training, which can be adapted to individual 
needs and interests, offers an interactive approach that lets you practice new 
techniques on numerous case studies.

NOTE Online training is available upon request. Contact support@theobjects.com for 
information about availability.
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Reporting Issues
Dragonfly includes an integrated reporting module that lets you include comments and 
other information along with generated DMP and log files whenever you encounter an 
issue that results in a crash or application freeze.

Send Report to ORS dialog

You should note that you can also report an issue at any time by choosing Help > 
Report an Issue on the menu bar.



This page left intentionally blank.


	Dragonfly 2021.1 Release Notes
	Contents
	New Features and Product Enhancements
	Segmentation Wizard
	Model Generation Strategy
	Default Strategies
	Updates for the Input Tab
	Updates for the Models Tab
	Updates for the Settings Tab
	Training Parameters
	Model Parameters
	Rename and Save Multiple Models
	Data Selection
	Open Wizard Session from the Menu Bar

	New Deep Learning Architectures
	Attention U-Net
	LinkNet
	U-Net++

	Updated Deep Learning Architectures
	PSPNet

	CT Reconstruction
	Stripe Removal Filters for Pre-Processing
	Updates for the CT Rotation Finder
	Support for YXLON Micro-CT Scans
	Metadata Parser for SKYSCAN

	Distributed Tasks
	Distributed Tasks Observer
	Distributed Task Dialog
	Updates for the Deep Learning Tool

	ROI Painter Panel
	New ROI Painter Tools
	Local Otsu Brush
	Adaptive Gaussian Brush
	Point & Click Brush
	Point & Click Outline Brush Preferences
	Path Brush

	Export Label Histograms
	Morphological Operations
	ROI and Mesh Opacity Settings
	Window Leveling Modes for 3D Views
	W/L Mode Preferences

	Image Filtering
	Thresholding for Unimodal Images
	Updates for Image Filters

	Three-Point Circle Tool
	Configured Actions for the Three-Point Circle Tool

	Thickness Meshes
	Organizer Updates
	Search Criteria
	Organizer Settings

	Plug Analysis
	Movie Maker
	2D Animations
	Support for H5 Files
	Additional Support for CZI Images
	Export Images to VTK

	Menu Bar Changes
	File Menu
	Utilities Menu

	Changes to Contextual Menus
	Dataset Pop-Up Menu
	Multi-ROI Pop-Up Menu

	Preferences Changes
	Views Preferences
	Configurable Actions

	Resolved Issues
	Labeling Multi-ROIs
	Working in 3D Views
	3D Settings for Loaded Sessions
	Issues with AMD Graphic Cards
	Movies Rendered in 4K
	Exported Screenshots
	Smoothing Meshes
	Interpolating ROIs

	System Requirements
	Publicly Available Source Code
	TensorFlow
	Qt

	Extending Dragonfly
	Requesting New Features
	Learning Dragonfly
	Dragonfly Workshops
	Online Training

	Reporting Issues



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.5
  /CompressObjects /All
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo false
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Arial-Black
    /Arial-BlackItalic
    /Arial-BoldItalicMT
    /Arial-BoldMT
    /Arial-ItalicMT
    /ArialMT
    /ArialNarrow
    /ArialNarrow-Bold
    /ArialNarrow-BoldItalic
    /ArialNarrow-Italic
    /CenturyGothic
    /CenturyGothic-Bold
    /CenturyGothic-BoldItalic
    /CenturyGothic-Italic
    /CourierNewPS-BoldItalicMT
    /CourierNewPS-BoldMT
    /CourierNewPS-ItalicMT
    /CourierNewPSMT
    /Georgia
    /Georgia-Bold
    /Georgia-BoldItalic
    /Georgia-Italic
    /Impact
    /LucidaConsole
    /Tahoma
    /Tahoma-Bold
    /TimesNewRomanMT-ExtraBold
    /TimesNewRomanPS-BoldItalicMT
    /TimesNewRomanPS-BoldMT
    /TimesNewRomanPS-ItalicMT
    /TimesNewRomanPSMT
    /Trebuchet-BoldItalic
    /TrebuchetMS
    /TrebuchetMS-Bold
    /TrebuchetMS-Italic
    /Verdana
    /Verdana-Bold
    /Verdana-BoldItalic
    /Verdana-Italic
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages false
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 288
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.04167
  /EncodeColorImages false
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages false
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 288
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.04167
  /EncodeGrayImages false
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages false
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<


    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e55464e1a65876863768467e5770b548c62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc666e901a554652d965874ef6768467e5770b548c52175370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>



    /HUN <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF adatti per visualizzare e stampare documenti aziendali in modo affidabile. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 6.0 e versioni successive.)
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020be44c988b2c8c2a40020bb38c11cb97c0020c548c815c801c73cb85c0020bcf4ace00020c778c1c4d558b2940020b3700020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200036002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken waarmee zakelijke documenten betrouwbaar kunnen worden weergegeven en afgedrukt. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 6.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>


    /SKY <>

    /SUO <>
    /SVE <>
    /TUR <>

    /ENU (Use these settings to create Adobe PDF documents suitable for reliable viewing and printing of business documents.  Created PDF documents can be opened with Acrobat and Adobe Reader 6.0 and later.)
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [648.000 828.000]
>> setpagedevice


